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前    言  
 
 
 
Python 语言诞生于 20 世纪 90 年代，是一种跨平台、开源、面向对象、解释型、动态数据

类型的高级计算机程序设计语言，在 Web 开发、科学计算、人工智能、大数据分析和系统运维

等领域得到广泛应用，深受人们的青睐。不论你是计算机类专业还是非计算机类专业的学生，

也不论你是否有一定的编程基础，如果你想学习 Python 语言，我们相信这都是一套比较好的入

门教材。 
随着计算机基础教育形式的不断更新，2018 年，大连民族大学计算机基础实验教学中心成

立了 Python 语言课组，课组成员有焉德军、李宏岩、郑江超、隋励丽、杨为明、若曼、郑智强、

王铎等多名老师。从课组成立开始，课组成员多次组织集体备课，进行 Python 语言程序设计集

中学习，并多次参加各类 Python 语言程序设计相关的培训班：2019 年 4 月，Python 语言课组

的五名教师，参加了在长沙举办的第三届全国高校 Python 语言与计算生态教学研讨会；2019
年 7 月，Python 语言课组全体成员参加了在南开大学举办的 Python 语言教学培训班；2019 年 8
月，Python 语言课组的两名教师参加了全国高校大数据联盟举办的 Python 编程及大数据分析教

师研修班；2020 年 1 月，Python 语言课组的两名教师参加了北京雷课教育举办的 Python 人工

智能及大数据分析研修班；2020 年 1 月，Python 语言课组全体成员参加了由东华大学举办的

Python 语言与大数据培训。经过一系列的培训和学习以及课组成员间的交流研讨，我们对于有

关 Python 语言课程的教学内容、教学方法、教学手段等有了深刻认识，增强了在全校大范围开

设 Python 语言程序设计课程的信心。2019 年秋季学期，计算机基础实验教学中心停开了已经

开设多年的VB程序设计课程和Access数据库课程，在全校 5个学院 21个专业新开设了Python
语言程序设计课程。 

经过两年的学习和教学实践，Python 语言课组积累了丰富的经验，着手编写适合高校非计

算机专业学生学习的教材《Python 语言程序设计入门》和实验教程《Python 语言程序设计入门

实验指导》。《Python 语言程序设计入门》以全国计算机等级考试二级 Python 语言程序设计考

试大纲为指导，围绕 Python 的基础语法和数据结构组织编排讲授内容，包含 Python 概述、Python
语言基础、Python 程序的控制结构、函数、组合数据类型、文件和数据格式化以及模块、包与

库的使用，此外还涉及图形用户界面程序设计等。《Python 语言程序设计入门实验指导》则包

含四部分内容：与主教材内容相关的 14 个实验项目；《Python 语言程序设计入门》习题解答；

Python 语言的二级等级考试大纲和模拟题；网络爬虫、数据分析，数据可视化等项目实训。 
为了更好地开展线上线下混合模式教学，结合教材，我们录制了 44 个 MOOC 教学视频，

总时长 630 分钟，在中国大学 MOOC 的 SPOC 学校专有课程(大连民族大学)上线

(http://www.icourse163.org/course/preview/DLNU-1461020176?tid=1461806466)。同时，基于“百

科园通用考试平台”，我们构建了 Python 语言程序设计题库，为实施过程化考核和形成性评价
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奠定了扎实基础。 
为了更好地开展课程思政，结合教学内容，我们合理地设计了一些课程思政案例，如鸿蒙

操作系统、社会主义核心价值观知识问答程序、习近平总书记在庆祝中华人民共和国成立 70
周年大会上的讲话词频分析、《中共中央关于坚持和完善中国特色社会主义制度、推进国家治

理体系和治理能力现代化若干重大问题的决定》词云图、绘制五星红旗等，所有这些课程思政

案例，与教学内容紧密结合，不突兀，不牵强，因势利导、顺势而为地自然融入，起到润物无

声、潜移默化的效果。在潜移默化中，让学生增长见识，坚定学生的理想信念，激发学生的爱

国热情，培养学生具有民族自信心和维护国家利益的责任感，唤醒学生“为中华之崛起而读书”

的原动力。 
本套教材以程序设计初学者为对象，由浅入深、循序渐进地讲述 Python 语言的基本概念、

基本语法和数据结构等基础知识，包括 Python 语言开发环境的安装、变量与数据类型、程序控

制结构、函数和模块、文件、Python 标准库和第三方库应用等。 
程序设计初学者通过学习本套教材，可以快速掌握程序设计的基本思想和一般方法，达到

如下目标。 
知识传授目标：掌握 Python 语言的数据类型、基本控制结构、函数设计以及部分标准

库和扩展库的使用；理解文件的基本处理方法；了解当下热门领域的 Python 扩展库的

使用方法。 
能力培养目标：让学生具有分析问题、解决问题的能力，以及计算思维和信息素养，

掌握程序设计方法，具备利用 Python 语言编程解决实际问题的能力。 
价值塑造目标：将科技创新、爱国主义精神等思政元素融入教学，着眼于学生道德素

养的熏陶濡染，培养学生一丝不苟、严谨认真、求真务实的工作态度和工匠精神，为

学生学习后续课程、参加工作和开展科学研究打下良好基础。 
在本套教材的编写过程中，我们参阅了很多 Python 语言方面的图书资料和网络资源，借鉴

和吸收了其中的很多宝贵经验，在此向相关作者表示衷心的感谢。由于编者水平有限，书中难

免有疏漏之处，敬请各位同行和读者批评指正，在此表示感谢。我们的邮箱是 992116@qq.com，

电话是 010-62796045。 
 
 
 
 
 
 
 

                                                          编 者    
2021 年 4 月 
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第 1 章  实 验 内 容 

本章给出了 14 个实验，每个实验与主教材《Python 语言程序设计入门》中的主题是对应

的。教师可根据实际情况选取实验以及其中的内容。 

实验一  熟悉 IDLE 集成开发环境 

1. 实验目的 

(1) 熟悉 Python 开发环境 IDLE 的两种程序模式：交互模式和文件模式。 
(2) 通过编辑和运行给出的程序，掌握如何在计算机上创建、编辑、运行 Python 程序。 

2. 实验准备 

(1) 阅读主教材第 1 章的主要内容。 
(2) 了解实验内容。 

3. 实验内容 

1) 单击【开始】→【程序】→Python 3.7→IDLE(Python 3.7)，打开 IDLE，如图 1-1 所示，

打开 IDLE 后进入的是 shell 模式，这是一种交互式的运行模式。 

 
图 1-1  Python 自带的集成开发环境 
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(1) 在交互窗口中输入 print("Hello World")后换行并查看结果(注意所有标点符号应是英文

符号)。 
(2) 利用交互窗口计算下列表达式的值，每输入一行表达式就换行并查看结果： 

>>> 99 + 88 - 5*6 
>>> (18 + 36)*7 / 2 
>>> 2 * 8 
>>> 2 ** 8 
>>> 17 / 3 
>>> 17 % 3 

(3) 输入 x=input()后换行，然后输入任意一个数字并换行，在看到提示符>>>后，直接输入

x 后换行并查看结果。 
2) 选择交互窗口中的 File→New File 菜单命令以创建 Python 脚本文件并打开 Editor 窗口。 
(1) 输入下面的程序后保存脚本文件，命名为 test01.py，运行脚本程序，查看程序运行结果。 

# -*- coding: utf-8 -* 
##海龟绘图小程序 
import turtle 
turtle.speed("fastest") 
turtle.pensize(2) 
for x in range(6):  
    turtle.forward(100)         
    turtle.left(60)        #  角度的控制参数不同，绘制的图像也不同 

(2) 选中代码的最后两行，在 Editor 窗口中选择 Format→Dedent Region，然后选择 Run→
Run Module 菜单命令，运行当前脚本文件，并在交互窗口中输出运行结果。观察与之前代码的

区别，并尝试解释原因。 
(3) 选中代码的最后两行，在 Editor 窗口中选择 Format→Indent Region，然后选择 Run→

Run Module 菜单命令，运行当前脚本文件，并在交互窗口中输出运行结果。观察与之前代码的

区别，并尝试解释原因。 
(4) 选中代码的前两行，在 Editor 窗口中选择 Format→UnComment Region，然后选择 Run

→Run Module 菜单命令，运行当前脚本文件，并在交互窗口中输出运行结果。观察与之前代码

的区别，并解释原因。 
(5) 选中代码的前两行，在 Editor 窗口中选择 Format→Comment out Region，然后选择 Run

→Run Module 菜单命令，运行当前脚本文件，并在交互窗口中输出运行结果。观察与之前代码

的区别，并解释原因。 
3) 打开指定位置的 Python 文件 test01-3.py，运行后查看运行结果。 

实验二  数据类型 

1. 实验目的 

(1) 通过实验加深对数据类型的理解，熟悉数字型、字符型变量的用法。 
(2) 掌握基本输入输出函数的使用方法。 
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(3) 掌握 Python 常用内置函数的使用方法。 

2. 实验准备 

(1) 阅读主教材第 2 章的有关内容。 
(2)  IDLE 环境中的相关操作请阅读主教材第 1 章的主要内容。 
(3) 了解实验内容。 

3. 实验内容 

(1) 程序填空：在画线处将程序补充完整，使程序运行正确。以下程序的功能是：输入一

个正整数，输出对应的平方。例如，当输入 5 时，输出 25。 

''' 
输入一个正整数 x， 
输出这个正整数的平方。 
''' 
________ 
print("x 的平方是：",x**2)  

(2) 程序填空：在画线处将程序补充完整，使程序运行正确。以下程序的功能是：输入一

个十进制整数，输出对应的二进制数、八进制数和十六进制数。例如，当输入26时，输出0b11010、
0o32 和 0x1a。 

''' 
输入一个十进制数 x， 
输出对应的二进制数、八进制数和十六进制数。 
''' 
________ 
print("{}的二进制形式是{}、八进制形式是{}、十六进制形式是{}：".________)  

(3) 程序填空：在画线处将程序补充完整，使程序运行正确。以下程序的功能是：按照指

定的模板输出列表里的内容。模板为：“×××同学，你已被我校×××学院×××专业录取，

请于××年××月××日准时到我校报到”。 

''' 
按照指定的模板输出列表里的内容， 
模板为：×××同学，你已被我校×××学院×××专业录取，请于××年××月××日准时到我校报到 
''' 
student=['王若飞','经济管理','会计','2020-9-7'] 
print(________)  

(4) 已知直角三角形的两条直角边，编写程序，求斜边的长度并输出。 
(5) 编写程序，求下列字符串中最长的英文单词。 
A startup backed by the Japanese automaker has developed a test model that engineers hope will 

eventually develop into a tiny car with a driver who'll be able to light the Olympic torch in the 2020 
Tokyo games. 
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(6) 编写程序，计算下面这组成绩的总分、平均分、最高分和最低分。 
42, 85, 84, 91, 97, 73, 72, 60, 84, 79, 69, 57, 48, 88, 86, 97, 90, 86, 81 

实验三  运算符和表达式 

1. 实验目的 

(1) 通过实验加深理解常用的运算符及表达式。 
(2) 掌握自动类型转换规则和强制类型转换方法。 
(3) 掌握运算符的优先级和结合性。 
(4) 理解表达式的求解过程。 

2. 实验准备 

(1) 阅读主教材第 2 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：在画线处将程序补充完整，使程序运行正确。以下程序的功能是：输入一

个两位的正整数，按倒序输出。例如，当输入 56 时，输出 65。 

''' 
输入一个两位的正整数， 
按倒序输出。 
''' 
x=int(input('输入一个两位的正整数：')) 
a=________ 
b=________ 
print('x 的倒序输出是',b*10+a)  

(2) 程序填空：在画线处将程序补充完整，使程序运行正确。以下程序的功能是：输入两

个点的坐标，计算并输出这两点之间的距离，要求精确到小数点后两位。 

''' 
输入两个点的坐标， 
计算这两点之间的距离，精确到小数点后两位。 
''' 
x1,y1=________(input('输入第一个点的坐标，用逗号分隔：')) 
x2,y2=________(input('输入第二个点的坐标，用逗号分隔：')) 
p=________ 
print('点({},{})和点({},{})之间的距离是{}'.format(________) )  

(3) 编写程序：输入一个 3 位的正整数，输出其各位数字的立方之和。例如，当输入 312
时，输出 36。 

(4) 编写程序：输入一个字符串和一个英文字母，统计这个英文字母在字符串中出现的次

数，注意不区分大小写。 
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实验四  选择结构 

1. 实验目的 

(1) 通过实验加深理解结构化程序设计。 
(2) 掌握 if、if-else 和 if-else-elif 语句的使用方法。 
(3) 掌握 Python 结构化程序设计的语法规则。 

2. 实验准备 

(1) 阅读主教材第 3 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：随机生成一个整数，判断是否为奇数并输出结果。在画线处补充完整下列

程序，使程序运行正确。 

''' 
随机生成一个整数，判断是否为奇数并输出结果 
''' 
import ________ 
x=________.randint(1,100) 
if ________ : 
    print('{}是奇数'.format(x)) 
________ : 
    print('{}是偶数'.format(x))  

(2) 程序填空：以下程序的功能是——输入学生的成绩，输出与成绩对应的等级。等级的

划分标准如下。 
[90~100]：优秀 
[80~90]：良好 
[70~80]：中等 
[60~70]：及格 
[0~60]：不及格 
另外，程序还要能够验证输入的成绩是否在有效范围内。 
在画线处补充完整下列程序，使程序运行正确。 

''' 
输入学生成绩，输出对应等级。 
[90~100]：优秀。[80~90)：良好。[70~80)：中等。[60~70)：及格。[0~60)：不及格。 
''' 
score=eval(input('请输入学生成绩：')) 
if ________ : 
    print('有效成绩应该在 1~100 范围内！') 
elif ________ : 
    print('{}的等级为优秀'.format(score)) 
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elif ________ : 
    print('{}的等级为良好'.format(score))    
elif ________ : 
    print('{}的等级为中等'.format(score)) 
elif ________ : 
    print('{}的等级为及格'.format(score)) 
________ : 
    print('{}的等级为不及格'.format(score))  

(3) 编写程序：要求使用 if 语句，输入 x 后按下式计算 y 值并输出。 
2

3

10        0 8
10        <0 >8

x x
y

x x x

 += 
− 或

≤ ≤
 

(4) 编写程序：从键盘输入一个字符，如果是数字字符，则输出“这是一个数字字符”；

如果是 26 个英文大写字母，则输出“这是一个大写英文字符”；如果是 26 个英文小写字母，

则输出“这是一个小写英文字符”；否则，输出“这是其他字符”。 

实验五  循环结构 

1. 实验目的 

(1) 通过实验加深理解结构化程序设计。 
(2) 掌握 while、for…in range():语句的使用方法。 
(3) 学会使用顺序结构、选择结构和循环结构编写普通程序。 

2. 实验准备 

(1) 阅读主教材第 3 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：以下程序的功能是求 1~100 的奇数和与偶数和并输出结果。在画线处补充

完整下列程序，使程序运行正确。 

''' 
计算 1~100 的奇数和与偶数和并输出结果 
''' 
s1=s2=0 
for i in range(________ ): 
    if ________ : 
        s1 += i 
    else: 
        s2 += i 
print('1~100 的奇数和是{}、偶数和是{}'.format(________ ))  

(2) 程序填空：输入一个整数，判断并输出它是一个几位数。例如，当输入 32767 时，输

出 32767 是 5 位数。在画线处补充完整下列程序，使程序运行正确。 
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''' 
输入一个整数，判断并输出它是一个几位数。 
''' 
x = int(input('')) 
n = 0 
while  ________: 
    n += 1 
    x //= ________ 
print('{}是{}位数'.format(x,n))  

(3) 编写程序：计算 1!+2!+3!+…+10!(可分别使用循环嵌套和 math 库中的 factorial 函数来

求解)。 
(4) 编写程序：计算 Fibonacci 数列的第 40 项。Fibonacci 数列如下： 

1，1，2，3，5，8，13，21，… 

Fibonacci 数列的特点是：前两项都是 1，从第 3 项开始，后面的每一项都是前两项之和。 

实验六  函数 

1. 实验目的 

(1) 掌握定义函数的方法。 
(2) 掌握调用函数的方法。 
(3) 学会用函数编写程序。 

2. 实验准备 

(1) 阅读主教材第 4 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：fun 函数的功能是根据两个直角边 x 和 y，计算并返回斜边的长度。在画线

处补充完整下列程序，使程序运行正确。 

def fun(x,y): 
    return ________ 
leg1,leg2=eval(input('输入两条直角边，以逗号分隔：')) 
print('斜边的长度为：{:.2f}'.format(________)) 

(2) 程序填空：函数 circle_area 用于计算半径为 r 的圆的面积，默认的圆周率 P 为 3.14，在

画线处补充完整下列程序，使程序运行正确。 

# 定义函数 
def circle_area(r,P=3.14): 
    ''' 
    参数 r 为圆的半径，P 是圆周率，默认为 3.14， 
    返回半径 r 对应的圆的面积。 
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    ''' 
    area = 0 
    if r > 0: 
        area = P * r ** 2 
    return area 
 
print("半径为{}时，圆的面积是{:.3f}".format(3, ________))     
print("半径为{}、π为 3.14 时，圆的面积是{:.3f}".format(3, ________)) 

(3) 程序填空：列表 list1 中保存了 5 名参赛选手的评委打分，每组有 6 位评委，请计算每

组选手的得分。 
计算规则：去掉最高分和最低分，剩下的计算平均分作为选手的最后得分。 
其中，函数 zf 用来计算选手得分。 
在画线处补充完整下列程序，使程序运行正确。 

def zf(ls): 
    return (sum(ls)-max(ls)-min(ls))/(len(ls)-2) 
list1=[ [7,8,7.5,8.3,8.2,7.8], 
     [8,8.3,8.5,8.8,8.2,7.8], 
     [9,8,7.5,8.3,8.2,8.8], 
     [6,7,7.5,7.3,7.2,7.8], 
     [8,9,9,8.8,9,10]] 
for i in range(5): 
    print("第{}名选手的得分是{:.1f}".format(i+1,zf(________)))  

(4) 程序填空：以下程序的功能是输入长方体的长、宽、高后，计算长方体的体积。在画

线处补充完整下列程序，使程序运行正确。 

V=lambda ________ 
leg1,leg2,leg3=eval(input('输入长、宽、高，用逗号分隔：')) 
print('体积为',V(leg1,leg2,leg3)) 

(5) 程序设计：编写函数 fun，功能是计算如下多项式。 

!!3!2
1

32

n
xxxxs

n

+++++= 
 

(6) 程序设计：编写函数 fun，功能是求 n 以内(不包括 n)同时能被 3 与 7 整除的所有自然

数之和的平方根 s，并作为函数值返回。 

实验七  列表与元组 

1. 实验目的 

(1) 掌握列表、元组的定义和使用方法。 
(2) 掌握列表、元组的常用操作。 
(3) 学会使用列表编写程序。 
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2. 实验准备 

(1) 阅读主教材第 5 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：以下程序的功能是生成一个元素都是 26 个大写英文字母的列表。在画线处

补充完整下列程序，使程序运行正确。 

ls=[________ for x in range(65,91) ] 
print(ls) 

(2) 程序填空：以下程序的功能是——创建列表 ls，列表元素为随机生成的[1,100]范围内的

整数，初始个数为20，然后删除列表中3的倍数，降序排列后输出(使用 random库中的 randint(a,b)
函数可以随机生成[a,b]范围内的整数)。在画线处补充完整下列程序，使程序运行正确。 

import random 
ls=[random.randint(1,100) ________ ] 
print(ls) 
for i in range(________): 
    if  ls[i] % 3==0: 
        ________ 
ls. ________ 
print(ls)  

(3) 程序设计：创建一个列表元素为 12 星座符号的列表并输出。 
(4) 程序设计：下面的 psls 列表为学生的平时成绩，qmls 列表为学生的期末成绩，请按照

平时成绩×20%+期末成绩×80%的规则为每位学生计算总成绩，期末成绩缺失的按旷考标注。 

psls=[75,75,75,65,85,95,85,75,75,75,85,75,75,65,75] 
qmls=[68,63,70,51,78,83,75,66,70,73,85,67,78,60,66] 

实验八  字典与集合 

1. 实验目的 

(1) 掌握字典、集合的定义和使用方法。 
(2) 掌握字典、集合的常用操作。 
(3) 学会使用字典编写程序。 

2. 实验准备 

(1) 阅读主教材第 5 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：以下程序的功能是通过输入生成大连民族大学学院与代码对应的字典
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xydm，该字典以代码为键、以学院名称为值，最后输入–1 以结束创建过程并输出字典 xydm
中的键值对。在画线处补充完整下列程序，使程序运行正确。 

xydm={} 
x=input("请输入学院代码：") 
while ________!=-1: 
    y=input("请输入学院名称：") 
    ________ 
    x=input("请输入学院代码：") 
print('创建的字典内容是：') 
for key,value in xydm.items(): 
    print(________) 

(2) 程序填空：以下程序的功能是统计字符串中每个字符出现的次数并将统计结果输出，

字符串的内容为'The Python Software'。在画线处补充完整下列程序，使程序运行正确。 

z='The Python Software' 
print("字符串：",z) 
d= ________ 
for c in z: 
    d[c]=d.get(________)+1 
print('每个字符出现的次数是：') 
for key in d: 
    print(key, ________) 

(3) 程序填空：以下程序的功能是输入密码，然后判断并输出密码的强度。密码强度的判

定标准如下。 
弱密码：长度小于 8 位，全数字、全小写字母或全大写字母。 
中密码：长度大于 8 位，包含数字、小写字母、大写字母中的任意两种。 
强密码：长度大于或等于 10 位，包含数字、小写字母、大写字母。 
在画线处补充完整下列程序，使程序运行正确。 

pw=input("请输入密码：") 
pws=[0,0,0,0]   #列表元素分别表示密码长度，包含了密码中含有数字、大写字母、小写字母的情况 
strength={5:'强',4:'中',3:'中等偏弱',2:'弱',1:'差'} 
 
if 6<len(pw)<=8: 
    pws[0]=1 
elif  ________: 
    pws[0]=2 
for x in pw: 
    if x.isdigit(): 
        pws[1]=1 
    elif  ________: 
        pws[2]=1 
    elif x.islower() : 
        pws[3]=1 
n= ________ 
print('密码的强度为',strength[n]) 
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(4) 编写程序：输入学生的学号，输出学生所属的年级和学院信息。 
学号规则如下：入学年份(4位)+学院代码(2位)+专业代码(1位)+班级代码(1位)+序号(2位)。 
学院信息存储在字典 xydm 中： 

xydm={'01':'经济管理学院','02':'机电学院','03':'生命科学院','04':'外国语学院', 
      '05':'理学院','06':'文法学院','08':'计算机学院'} 

实验九  文件与数据格式化 

1. 实验目的 

(1) 通过实验加深理解文本文件和二进制文件的概念和特点。 
(2) 掌握文件的建立、读写和关闭方法。 
(3) 熟悉 CSV 文件的处理方法。 
(4) 了解 JSON 文件的处理方法。 

2. 实验准备 

(1) 阅读主教材第 6 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：以下程序的功能是创建一个列表，列表元素是随机的两位正整数，元素个

数为 20，将这些数字写入 0801.txt 文件中，一个数字占一行。在画线处补充完整下列程序，使

程序运行正确。 

from random import * 
ls=[________  for i in range(20)] 
fp=open('0801.txt',________) 
for i in range(20): 
    fp.write(str(ls[i])+ ________) 
________ 

(2) 程序填空：以下程序的功能是将文件 0801.txt 中的数据读入列表中，并在一行内以空格

作为输出列表内容时的分隔符。在画线处补充完整下列程序，使程序运行正确。 

fp= ________ 
s=fp.read() 
fp.close() 
ls=________ 
for item in ls: 
    print(item, ________)  

(3) 程序填空：文件 0803.csv 中是用户名、手机号和验证码信息，以下程序的功能是从该

文件中读取这些数据到 user 列表中，并按行输出列表信息，一行内的数据用逗号分隔(如图 1-2
所示)。在画线处补充完整下列程序，使程序运行正确。 
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图 1-2  按行输出列表 user 中的内容 

f = open(________)            
user = [] 
for line in f: 
    user.append(line.strip('\n'). ________)            
f.close()                                     
for item in user: 
    print(________)  

(4) 编写程序：求 Fibonacci 数列的前 40 项，并将它们保存到文件 0604.txt 中。Fibonacci
数列如下： 

1，1，2，3，5，8，13，21，… 

实验十  turtle 库的使用 

1. 实验目的 

(1) 掌握 Python 标准库的导入和使用方法。 
(2) 能正确使用绘图库 turtle，掌握 turtle 常用的绘图方法。 
(3) 学会使用 turtle 库编写普通程序。 

2. 实验准备 

(1) 阅读主教材第 7 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：以下程序的功能是在坐标(100,–100)的位置绘制一个半径为 75 的圆。 
在画线处补充完整下列程序，使程序运行正确。 

import ________ 
t. ________ 
t.goto(100,-100) 
t.pendown() 
t. ________ 

(2) 程序填空：以下程序的功能是绘制如图 1-3 所示的图形。在画线处补充完整下列程序，

使程序运行正确。 
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图 1-3  所要绘制的图形 

________ 
pensize(2) 
pencolor('blue') 
seth(________) 
d=10 
for i in range(100): 
    fd(________) 
    right(________)  

(3) 程序设计：绘制五星红旗。 

实验十一  random 库的使用 

1. 实验目的 

(1) 能正确使用 random 库，掌握 random 库中常用的方法。 
(2) 学会使用 random 库编写普通程序。 

2. 实验准备 

(1) 阅读主教材第 7 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：以下程序的功能是在画布上的任意位置绘制随机数量的小花，其中的 flower
函数用于在当前位置绘制一朵小花。在画线处补充完整下列程序，使程序运行正确。 

________ 
import random 
def flower(): 
    tracer(False)     
    pensize(2) 
    begin_fill() 
    color("yellow") 
    dot(60)       #中间圆点 
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    right(90) 
    fd(30)      #花瓣起点 
    color("red") 
    circle(15,231)      
    for i in range(6): 
        right(180) 
        circle(15,231) 
    end_fill()     #花瓣完成 
 
n=random.randint(1,10) 
Width=screensize()[0]   #获取画布的宽度 
height=screensize()[1]   #获取画布的高度 
for i in range(n): 
    ________ 
    x=random.randint(________,Width) 
    y=random.randint(________,height) 
    ________ 
    pendown() 
    ________ 

(2) 程序填空：以下是某班级的元旦抽奖程序，三等奖 2 名，二等奖 1 名，一等奖 1 名，

其中的 student 列表是学生名单。在画线处补充完整下列程序，使程序运行正确。 

import random 
student=['王东','李明','马斌','张伟平','周红','孙小伟', 
       '郑晓龙','赵平','吴铭','王芳','李红','刘明天', 
       '张小武','李铭博','何伟'] 
print('三等奖获得者是：',end=' ') 
for i in range(________): 
    n=random.randint(0, ________) 
    print(student[n],end=' ') 
    del student[n] 
print() 
print('二等奖获得者是：',end=' ') 
n=random.randint(0, ________) 
print(student[n]) 
________ 
print('一等奖获得者是：',end=' ') 
n=random.randint(0, ________) 
print(student[n]) 
del student[n]  

实验十二  第三方库 

1. 实验目的 

(1) 掌握 Python 中第三方库的安装和使用方法。 
(2) 掌握 jieba 库的使用方法。 
(3) 掌握 wordcloud 库的使用方法。 
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(4) 学会使用第三方库编写程序。 

2. 实验准备 

(1) 阅读主教材第 7 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

(1) 程序填空：以下程序的功能是利用 jieba 库对习近平总书记在中非团结抗疫特别峰会上

的主旨讲话进行词频分析，并输出使用频率最高的 10 个词，其中不统计“地”“的”“得”和

标点符号出现的频率。在画线处补充完整下列程序，使程序运行正确。 

import jieba 
text = ''' 
习近平在讲话中指出，这次抗击新冠肺炎疫情，是对国家治理体系和治理能力的一次大考。要研究和加强

疫情防控工作，从体制机制上创新和完善重大疫情防控举措，健全国家公共卫生应急管理体系，提高应对突发

重大公共卫生事件的能力水平。 
习近平强调，要强化公共卫生法治保障，全面加强和完善公共卫生领域相关法律法规建设，认真评估传染

病防治法、野生动物保护法等法律法规的修改完善。要从保护人民健康、保障国家安全、维护国家长治久安的

高度，把生物安全纳入国家安全体系，系统规划国家生物安全风险防控和治理体系建设，全面提高国家生物安

全治理能力。要尽快推动出台生物安全法，加快构建国家生物安全法律法规体系、制度保障体系。 
***************省略********************** 
习近平强调，要健全统一的应急物资保障体系，把应急物资保障作为国家应急管理体系建设的重要内容，

按照集中管理、统一调拨、平时服务、灾时应急、采储结合、节约高效的原则，尽快健全相关工作机制和应急

预案。要优化重要应急物资产能保障和区域布局，做到关键时刻调得出、用得上。对短期可能出现的物资供应

短缺，建立集中生产调度机制，统一组织原材料供应、安排定点生产、规范质量标准，确保应急物资保障有序

有力。要健全国家储备体系，科学调整储备的品类、规模、结构，提升储备效能。要建立国家统一的应急物资

采购供应体系，对应急救援物资实行集中管理、统一调拨、统一配送，推动应急物资供应保障网更加高效安全

可控。 
''' 
words = jieba. ________ 
 
word_freq = {} 
for word in words: 
    if len(word) >1: 
        word_freq[word] = ________ + 1       
         
items = list(word_freq.items()) 
items.sort(key=lambda x: x[1],reverse=True)                
 
for i in range(10): 
    word,freq = ________ 
    print("{}:{}".format(word,freq)) 

(2) 程序设计：在上一题的基础上对分词结果进行分析并生成词云图。 
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实验十三  界面设计 

1. 实验目的 

(1) 通过实验了解 tkinter 图形用户界面设计的编程方法。 
(2) 了解 tkinter 中各个组件的使用方法。 
(3) 了解图形用户界面设计中事件编程的使用方法。 

2. 实验准备 

(1) 阅读主教材第 8 章的有关内容。 
(2) 了解实验内容。 

3. 实验内容 

程序设计：设计图 1-4 所示的计算器界面。 

 
图 1-4  计算器界面 

实验十四  综合设计 

1. 实验目的 

(1) 通过实验了解较大程序的设计方法。 
(2) 掌握结构化程序设计方法。 

2. 实验准备 

(1) 复习主教材各章主要内容。 
(2) 了解实验内容。 

3. 实验内容 

编写程序，统计《三国演义》小说中曹操、诸葛亮、刘备、关羽、张飞、赵云、孙权、周

瑜、袁绍等角色的出场次数。 
要求： 
(1) 在进行统计时，角色的别称也应纳入统计范围。比如，曹操的别称有“孟德”“丞相”

等，刘备的别称有“玄德”“皇叔”等。 
(2) 将统计结果保存到文件中。 
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第 2 章  实验内容参考答案 

实验一  熟悉 IDLE 集成开发环境 

1) 略。 
2) 选择交互窗口中的 File→New File 菜单命令以创建 Python 脚本文件并打开 Editor 窗口。 
(1) 略。 
(2) 减少了缩进，改变了程序结构。 
(3) 增加了缩进，还原了程序结构，程序能够正常运行。 
(4) 去掉了原有的注释符号，影响了程序的运行。 
(5) 恢复了注释符号，程序可以正常运行。 
3) 在打开指定位置的 Python 文件 test01-3.py 时，不能采用双击的方式，而应该选中

test01-3.py 文件，然后右击，从弹出的菜单中选择 Edit with IDLE 命令。 

实验二  数据类型 

(1) 程序填空： 

x=int(input('输入一个整数')) 

(2) 程序填空： 

第一处：x=int(input()) 
第二处：format(x,bin(x),oct(x),hex(x))  

(3) 程序填空：  

"{}同学，你已被我校{}学院{}专业录取，请于{}日准时到我校报道".format(student[0],student[1], student[2], 
student[3]) 

(4) 已知直角三角形的两条直角边，编写程序，求斜边的长度并输出。 

''' 
已知直角三角形的两条直角边，编写程序，求斜边的长度并输出 
''' 
x,y=eval(input("输入两个直角边，以英文逗号分隔；")) 
c=(x**2+y**2)**0.5 
print("斜边的长度为",c) 

运行结果： 

输入两个直角边，以英文逗号分隔：3,4 
斜边的长度为 5.0 
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(5) 编写程序，求下列字符串中最长的英文单词。 
A startup backed by the Japanese automaker has developed a test model that engineers hope will 

eventually develop into a tiny car with a driver who'll be able to light the Olympic torch in the 2020 
Tokyo games. 

'''求下列字符串中最长的英文单词''' 
s='''A startup backed by the Japanese automaker has developed \ 
a test model that engineers hope will eventually develop into a tiny\ 
car with a driver who'll be able to light the Olympic torch in the 2020 Tokyo games.''' 
wordlst=s.split() 
print(max(wordlst,key=len)) 

运行结果： 

eventually 

(6) 编写程序，计算下面这组成绩的总分、平均分、最高分和最低分。 
42, 85, 84, 91, 97, 73, 72, 60, 84, 79, 69, 57, 48, 88, 86, 97, 90, 86, 81 

'''计算下面这组成绩的总分、平均分、最高分和最低分''' 
score=[42, 85, 84, 91, 97, 73, 72, 60, 84, 79, 69, 57, 48, 88, 86, 97, 90, 86, 81] 
a,b,c=sum(score),max(score),min(score) 
d=a/len(score) 
print("总分：{}。平均分：{:.2f}。最高分：{}。最低分：{}。".format(a,d,b,c)) 

运行结果： 

总分：1469。平均分：77.32。最高分：97。最低分：42。 

实验三  运算符和表达式 

(1) 程序填空：  

第一处：x//10 
第二处：x%10 

(2) 程序填空：  

第一处：eval 
第二处：eval 
第三处：x1,y1,x2,y2,p 

(3) 编写程序：输入一个 3 位的正整数，输出其各位数字的立方之和。例如，当输入 312
时，输出 36。 

''' 
输入一个 3 位的正整数，输出其各位数字的立方之和 
''' 
num=int(input()) 
a,b,c=num//100,num%100//10,num%10 
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print('{}的各位数字的立方之和为{}'.format(num,a**3+b**3+c**3)) 

运行结果： 

321 
321 的各位数字的立方之和为 36 

(4) 编写程序：输入一个字符串和一个英文字母，统计这个英文字母在字符串中出现的次

数，注意不区分大小写。 

''' 
输入一个字符串和一个英文字母，统计这个英文字母在字符串中出现的次数，注意不区分大小写''' 
s=input('输入一个字符串：') 
c=input('输入一个英文字母：') 
s1,c1=s.lower(),c.lower() 
num=s1.count(c1) 
print('字母{}出现的次数是{}'.format(c,num)) 

运行结果： 

输入一个字符串：this is a duck 
输入一个英文字母：s 
字母 s 出现的次数是 2 

实验四  选择结构 

(1) 程序填空： 

第一处：random 
第二处：random 
第三处：x%2==1 
第四处：else 

(2) 程序填空： 

第一处：score<0 or score>100 
第二处：score>=90 
第三处：score>=80 
第四处：score>=70；  
第五处：score>=60 
第六处：else 

(3) 编写程序：要求使用 if 语句，输入 x 后按下式计算 y 值并输出。 
2

3

10        0 8
10        <0 >8

x x
y

x x x

 += 
− 或

≤ ≤
 

''' 
输入 x 后按下式计算 y 值并输出 
''' 
x=eval(input("输入 x 的值：")) 
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if 0<x<8: 
    y=x**2+10 
else: 
    y=x**3-10 
print("y 的值是：",y) 

运行结果： 

输入 x 的值：4 
y 的值是：26 

(4) 编写程序：从键盘输入一个字符，如果是数字字符，则输出“这是一个数字字符”；

如果是 26 个英文大写字母，则输出“这是一个大写英文字符”；如果是 26 个英文小写字母，

则输出“这是一个小写英文字符”；否则，输出“这是其他字符”。 

c=input("输入一个字符：") 
if c.isupper(): 
    print("这是一个大写英文字母") 
elif c.islower(): 
    print('这是一个小写英文字母') 
elif c.isnumeric(): 
    print('这是一个数字字符') 
else: 
    print('这是其他字符') 

运行结果： 

输入一个字符：A 
这是一个大写英文字母 

实验五  循环结构 

(1) 程序填空： 

第一处：1,101 
第二处：i%2==1 
第三处：s1,s2  

(2) 程序填空：  

第一处：x 
第二处：10 

(3) 编写程序：计算 1!+2!+3!+…+10!(可分别使用循环嵌套和 math 库中的 factorial 函数来

求解)。 

''' 
计算 1！+2！+3！+ … + 10！。''' 
s=0 
for i in range(1,11): 
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    p=1 
    for j in range(1,i+1): 
        p *= j 
    s += p 
print(s) 

运行结果为 4 037 913。 
(4) 编写程序：计算 Fibonacci 数列的第 40 项。Fibonacci 数列如下： 
1，1，2，3，5，8，13，21，… 
Fibonacci 数列的特点是：前两项都是 1，第 3 项开始，后面的每一项都是前两项之和。 

''' 
计算 Fibonacci 数列的第 40 项。''' 
a=b=1 
for i in range(3,41): 
    c=a+b 
    a,b=b,c 
print(c) 

运行结果为 102 334 155。 

实验六  函数 

(1) 程序填空： 

第一处：(x**2+y**2)**0.5 
第二处：fun(leg1,leg2) 

(2) 程序填空 

第一处：circle_area(3) 
第二处：circle_area(3,3.1415926) 

(3) 程序填空： 

list1[i]  

(4) 程序填空： 

x,y,z:x*y*z 

(5) 程序设计：编写函数 fun，功能是计算如下多项式。 

!!3!2
1

32

n
xxxxs

n

+++++= 
 

# 编写函数 fun，计算多项式 
def factorial(n): 
    s=1 
    for i in range(1,n+1): 
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        s *= i 
    return s 
def fun(x,n): 
    s=1 
    for i in range(1,n+1): 
        s += x ** i/factorial(i) 
    return s 
x,n=eval(input('输入两个数，用英文逗号分隔：')) 
print('结果为',fun(x,n)) 

运行结果： 

输入两个数，用英文逗号分隔：2,4 
结果为 7.0 

(6) 程序设计：编写函数 fun，功能是求 n 以内(不包括 n)同时能被 3 与 7 整除的所有自然

数之和 s，并作为函数值返回。 

# 编写函数 fun，求 n 以内(不包括 n)同时能被 3 与 7 整除的所有自然数之和 s，并作为函数值返回。 
 
def fun(n): 
    s=0 
    for i in range(1,n): 
        if i %3 ==0 and i%7 ==0: 
            s+= i 
    return s 
n=eval(input('输入 n：')) 
print('结果为',fun(n)) 

运行结果： 

输入 n：56 
结果为 63 

实验七  列表与元组 

(1) 程序填空： 

chr(x) 

(2) 程序填空：  

第一处：for i in range(20) 
第二处：len(ls)-1,0,-1 
第三处：del ls[i] 
第四处：sort(reverse=False)  

(3) 程序设计：创建一个列表元素为 12 星座符号的列表并输出。 

ls=[chr(9800+i) for i in range(1,13) ] 
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print(ls) 

运行结果： 

['♉', '♊', '♋', '♌', '♍', '♎', '♏', '♐', '♑', '♒', '♓', '♔'] 

(4) 程序设计：下面的 psls 列表为学生的平时成绩，qmls 列表为学生的期末成绩，请按照

平时成绩×20%+期末成绩×80%的规则为每位学生计算总成绩，期末成绩缺失的按旷考标注。 

psls=[75,75,75,65,85,95,85,75,75,75,85,75,75,65,75] 
qmls=[68,63,70,51,78,83,75,66,70,73,85,67,78,60,66] 
zcj=[x*0.2+y*0.8 for x,y in zip(psls,qmls)] 
print(zcj) 

实验八  字典与集合 

(1) 程序填空： 

第一处：int(x) 
第二处：xydm[x]=y 
第三处：key,value,sep=":" 

(2) 程序填空： 

第一处：{} 
第二处：c,0 
第三处：d[key] 

(3) 程序填空： 

第一处：len(pw)>=10 
第二处：x.isupper() 
第三处：sum(pws) 

(4) 编写程序：输入学生的学号，输出学生所属的年级和学院信息。 
学号规则如下：入学年份(4位)+学院代码(2位)+专业代码(1位)+班级代码(1位)+序号(2位)。 
学院信息存储在字典 xydm 中： 
xydm={'01':'经济管理学院','02':'机电学院','03':'生命科学院','04':'外国语学院', 
      '05':'理学院','06':'文法学院','08':'计算机学院'} 

stuno=input('输入学号：') 
grad=stuno[:4] 
dm=stuno[4:6] 
xy=xydm.get(dm) 
if xy: 
    print("年级{}，所属学院是{}".format(grad,xy)) 

运行结果： 

输入学号：2020012210 
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年级 2020，所属学院是经济管理学院 

实验九  文件与数据格式化 

(1) 程序填空： 

第一处：randint(10,99) 
第二处：'w' 
第三处：'\n' 
第四处：fp.close() 

(2) 程序填空：  

第一处：open('0801.txt','r') 
第二处：s.split('\n') 
第三处：end=' ' 

(3) 程序填空：  

第一处：open('0803.csv','r')  
第二处：split(',') 
第三处：item,sep=',' 

(4) 编写程序：求 Fibonacci 数列的前 40 项，并将它们保存到 0604.txt 文件中。Fibonacci
数列如下： 

1，1，2，3，5，8，13，21，… 

f = open('0804.txt','w')            
a=b=1 
for i in range(3,41): 
    c=a+b 
    a,b=b,c 
    f.write(str(c)+'\n') 
    print(c) 
f.close()         

实验十  turtle 库的使用 

(1) 程序填空： 

第一处：turtle as t  
第二处：penup() 
第三处：circle(75) 

(2) 程序填空：  

第一处：from turtle import * 
第二处：45 
第三处：d+i*2 
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第四处：90 

实验十一  random 库的使用 

(1) 程序填空： 

第一处：from turtle import * 
第二处：penup() 
第三处：-width 
第四处：-heigh 
第五处：goto(x,y) 
第六处：flower() 

(2) 程序填空：  

第一处：2 
第二处：len(student)-1 
第三处：len(student)-1 
第四处：del student[n] 
第五处：len(student)-1 

实验十二  第三方库 

(1) 程序填空： 

第一处：lcut(text) 
第二处：word_freq.get(word,0) 
第三处：item[i] 

(2) 程序设计：在上一题的基础上对分词结果进行分析并生成词云图。 

import jieba 
import wordcloud 
text = ''' 
习近平在讲话中指出，这次抗击新冠肺炎疫情，是对国家治理体系和治理能力的一次大考。要研究和加强

疫情防控工作，从体制机制上创新和完善重大疫情防控举措，健全国家公共卫生应急管理体系，提高应对突发

重大公共卫生事件的能力水平。 
习近平强调，要强化公共卫生法治保障，全面加强和完善公共卫生领域相关法律法规建设，认真评估传染

病防治法、野生动物保护法等法律法规的修改完善。要从保护人民健康、保障国家安全、维护国家长治久安的

高度，把生物安全纳入国家安全体系，系统规划国家生物安全风险防控和治理体系建设，全面提高国家生物安

全治理能力。要尽快推动出台生物安全法，加快构建国家生物安全法律法规体系、制度保障体系。 
  ***************省略********************** 
习近平强调，要健全统一的应急物资保障体系，把应急物资保障作为国家应急管理体系建设的重要内容，

按照集中管理、统一调拨、平时服务、灾时应急、采储结合、节约高效的原则，尽快健全相关工作机制和应急

预案。要优化重要应急物资产能保障和区域布局，做到关键时刻调得出、用得上。对短期可能出现的物资供应

短缺，建立集中生产调度机制，统一组织原材料供应、安排定点生产、规范质量标准，确保应急物资保障有序

有力。要健全国家储备体系，科学调整储备的品类、规模、结构，提升储备效能。要建立国家统一的应急物资

采购供应体系，对应急救援物资实行集中管理、统一调拨、统一配送，推动应急物资供应保障网更加高效安全

可控。 
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''' 
words = jieba. lcut(text) 
txt=' 'join(words) 
w=wordcloud.WordCloud() 
w.generate(text) 
w.to_file('test1202.jpg') 

实验十三  界面设计 

程序设计：设计图 2-1 所示的计算器界面。 

 
图 2-1  计算器界面 

from tkinter import * 
root = Tk() 
# 200x200 代表初始化窗口的大小，后面的两个 280 代表在进行初始化时窗口所在的位置 
root.geometry('200x200+280+280') 
root.title('计算器示例') 
# Grid(网格)布局 
L1 = Button(root, text='1', width=5) 
L2 = Button(root, text='2', width=5) 
L3 = Button(root, text='3', width=5) 
L4 = Button(root, text='4', width=5) 
L5 = Button(root, text='5', width=5) 
L6 = Button(root, text='6', width=5) 
L7 = Button(root, text='7', width=5) 
L8 = Button(root, text='8', width=5) 
L9 = Button(root, text='9', width=5) 
L0 = Button(root, text='0') 
Lp = Button(root, text='.') 
L11=Button(root,text='+') 
L12=Button(root,text='-') 
L13=Button(root,text='*') 
L14=Button(root,text='/') 
L15=Button(root,text='=') 
L1.grid(row=0, column=0)           
L2.grid(row=0, column=1)           
L3.grid(row=0, column=2)           
L11.grid(row=0, column=3, sticky=E+W)     



 

 27 

第一篇  Python 程序设计实验指导

L4.grid(row=1, column=0)           
L5.grid(row=1, column=1)           
L6.grid(row=1, column=2)           
L12.grid(row=1, column=3, sticky=E+W)     
L7.grid(row=2, column=0)           
L8.grid(row=2, column=1)           
L9.grid(row=2, column=2)           
L13.grid(row=2, column=3, sticky=E+W)     
L0.grid(row=3, column=0, sticky=E+W)     # 跨两行，左右贴紧 
Lp.grid(row=3, column=1, sticky=E+W)     # 左右贴紧 
L15.grid(row=3, column=2, sticky=E+W)     
L14.grid(row=3, column=3, sticky=E+W)     
e1 = Entry(root) 
e1.grid(row=4,column=0,columnspan=4) 
root.mainloop() 

实验十四  综合设计 

编写程序，统计《三国演义》小说中曹操、诸葛亮、刘备、关羽、张飞、赵云、孙权、周

瑜、袁绍等角色的出场次数。 
要求： 
(1) 在进行统计时，角色的别称也应纳入统计范围。比如，曹操的别称有“孟德”“丞相”

等，刘备的别称有“玄德”“皇叔”等。 
(2) 将统计结果保存到文件中。 

import jieba 
txt = open("三国演义.txt", "r", encoding='utf-8').read() 
names = ['曹操','诸葛亮','刘备','关羽','张飞','赵云','孙权','周瑜','袁绍' ] 
words = jieba.lcut(txt) 
counts = {} 
for word in words: 
    if len(word) == 1: 
        continue 
    elif word == "孔明" or word == "孔明曰": 
        rword = "诸葛亮" 
    elif word == "关公" or word == "云长": 
        rword = "关羽" 
    elif word == "玄德" or word == "玄德曰": 
        rword = "刘备" 
    elif word == "孟德" or word == "丞相" or word == "操曰": 
        rword = "曹操" 
    else: 
        rword = word 
    counts[rword] = counts.get(rword,0) + 1 
items = list(counts.items()) 
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items.sort(key=lambda x:x[1], reverse=True) 
#输出角色的出场次数，保存到文件中 
f=open(("出场统计.txt", "w") 
for i in range(40): 
    word, count = items[i] 
    if word in names: 
        print ("{0:<10}{1:>5}".format(word, count)) 
        f.write("{}:{}\n".format(word, count)) 
f.close() 
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